
QGIS Application - Issues

# Tracker Status Priority Subject Assignee Updated# Tracker Status Priority Subject Assignee Updated

20707 Bug report Closed Normal Processing - clicking on Refactor fields returns a Python error Nyall Dawson 2018-12-04 02:20 AM

20707 Bug report Closed Normal Processing - clicking on Refactor fields returns a Python error Nyall Dawson 2018-12-04 02:20 AM

16245 Feature request Open Normal DB Manager: Dock the window 2017-05-01 12:44 AM

16245 Feature request Open Normal DB Manager: Dock the window 2017-05-01 12:44 AM

16200 Bug report Closed Normal [Processing] Warp (Reproject) throws Python error Victor Olaya 2017-04-04 03:54 AM

16200 Bug report Closed Normal [Processing] Warp (Reproject) throws Python error Victor Olaya 2017-04-04 03:54 AM

16199 Bug report Closed Normal Processing: Warp (Reproject) throws Python error 2017-02-16 01:48 AM

16199 Bug report Closed Normal Processing: Warp (Reproject) throws Python error 2017-02-16 01:48 AM

16105 Feature request Closed High [Processing] Add lwgeom provider to core Processing Victor Olaya 2017-02-03 04:06 AM

16105 Feature request Closed High [Processing] Add lwgeom provider to core Processing Victor Olaya 2017-02-03 04:06 AM

15973 Feature request Closed Normal Processing: GDAL Merge - add compression options Victor Olaya 2017-01-18 05:02 AM

15973 Feature request Closed Normal Processing: GDAL Merge - add compression options Victor Olaya 2017-01-18 05:02 AM

15654 Bug report Rejected Normal Processing: TrainImagesClassifier (libvm) returns an error message Victor Olaya 2017-05-03 07:18 PM

15654 Bug report Rejected Normal Processing: TrainImagesClassifier (libvm) returns an error message Victor Olaya 2017-05-03 07:18 PM

15643 Bug report Closed Severe/Regression Print composer: qgis crashes while changing colour 2016-10-03 01:26 AM

15643 Bug report Closed Severe/Regression Print composer: qgis crashes while changing colour 2016-10-03 01:26 AM

15642 Bug report Closed Normal Print composer:  Changing "orientation" in Page Setup has no effect 2017-12-19 01:13 AM

15642 Bug report Closed Normal Print composer:  Changing "orientation" in Page Setup has no effect 2017-12-19 01:13 AM

15641 Bug report Closed Normal Processing: Orfeo Optical Calibration throws Python error Victor Olaya 2017-05-01 11:06 AM

15641 Bug report Closed Normal Processing: Orfeo Optical Calibration throws Python error Victor Olaya 2017-05-01 11:06 AM

15559 Bug report Closed Normal Processing: Clip raster by mask (GDAL)  throws an error if the output is a temporary file Victor Olaya 2016-09-15 08:58 AM

15559 Bug report Closed Normal Processing: Clip raster by mask (GDAL)  throws an error if the output is a temporary file Victor Olaya 2016-09-15 08:58 AM

15550 Bug report Closed Normal Processing: activating a new provider causes QGIS to freeze for a few seconds Victor Olaya 2017-01-03 12:34 AM

15550 Bug report Closed Normal Processing: activating a new provider causes QGIS to freeze for a few seconds Victor Olaya 2017-01-03 12:34 AM

14227 Bug report Closed Normal Processing: Dissolve polygons (GDAL/OGR and GRASS v.dissolve) in the Modeler Victor Olaya 2016-02-08 01:12 PM

14227 Bug report Closed Normal Processing: Dissolve polygons (GDAL/OGR and GRASS v.dissolve) in the Modeler Victor Olaya 2016-02-08 01:12 PM

14129 Bug report Closed Normal Processing GDAL: console call not updated after changes Victor Olaya 2016-01-19 12:03 AM

14129 Bug report Closed Normal Processing GDAL: console call not updated after changes Victor Olaya 2016-01-19 12:03 AM

14115 Bug report Closed Severe/Regression Processing: GDAL Proximity - incorrect result if "Values" is not filled Victor Olaya 2016-01-29 02:07 PM

14115 Bug report Closed Severe/Regression Processing: GDAL Proximity - incorrect result if "Values" is not filled Victor Olaya 2016-01-29 02:07 PM

13933 Feature request Closed Normal Improve help file of "Import vector into POSTGIS" - error when fields have high precision values Giovanni Manghi 2018-02-02 09:41 AM

13933 Feature request Closed Normal Improve help file of "Import vector into POSTGIS" - error when fields have high precision values Giovanni Manghi 2018-02-02 09:41 AM

13563 Bug report Rejected Normal Processing: R plots are too small Victor Olaya 2017-05-03 07:35 PM

13563 Bug report Rejected Normal Processing: R plots are too small Victor Olaya 2017-05-03 07:35 PM

12871 Feature request Closed Normal Processing: Add InVEST Victor Olaya 2017-06-29 08:57 AM

12871 Feature request Closed Normal Processing: Add InVEST Victor Olaya 2017-06-29 08:57 AM

12870 Feature request Closed Normal Processing: Add PyGeoprocessing Victor Olaya 2017-06-29 08:58 AM

12870 Feature request Closed Normal Processing: Add PyGeoprocessing Victor Olaya 2017-06-29 08:58 AM

12801 Bug report Closed High Processing: "Join attributes table" doesn't work in batch mode Victor Olaya 2015-06-01 06:21 AM

12801 Bug report Closed High Processing: "Join attributes table" doesn't work in batch mode Victor Olaya 2015-06-01 06:21 AM

12183 Bug report Closed Normal Processing refactor fields: python error after trying to add a new field Victor Olaya 2015-02-11 11:12 PM

12183 Bug report Closed Normal Processing refactor fields: python error after trying to add a new field Victor Olaya 2015-02-11 11:12 PM

12182 Bug report Closed Normal Processing Refactor fields: error while  adding new field that results from the sum of two existing fields Victor Olaya 2015-02-11 11:12 PM

12182 Bug report Closed Normal Processing Refactor fields: error while  adding new field that results from the sum of two existing fields Victor Olaya 2015-02-11 11:12 PM

12181 Bug report Closed Normal Attributes table: can't unselect lines by dragging the cursor up 2015-02-11 02:18 AM

12181 Bug report Closed Normal Attributes table: can't unselect lines by dragging the cursor up 2015-02-11 02:18 AM

12171 Bug report Closed Normal Processing Refactor fields: can't change an "int" field to "double" with 0 precision 2019-03-09 04:09 PM

12171 Bug report Closed Normal Processing Refactor fields: can't change an "int" field to "double" with 0 precision 2019-03-09 04:09 PM

12095 Feature request Closed Normal Processing: Vector layer scatterplot doesn't display the names of the XY attributes Victor Olaya 2015-04-10 06:30 AM

12095 Feature request Closed Normal Processing: Vector layer scatterplot doesn't display the names of the XY attributes Victor Olaya 2015-04-10 06:30 AM

12094 Bug report Closed Normal Processing: Raster layer histogram from QGIS algorithms throws a python error Giovanni Manghi 2015-02-03 12:12 AM

12094 Bug report Closed Normal Processing: Raster layer histogram from QGIS algorithms throws a python error Giovanni Manghi 2015-02-03 12:12 AM

12035 Bug report Closed Severe/Regression v.buffer creates shapefile with no .prj Victor Olaya 2015-01-22 07:44 AM

12035 Bug report Closed Severe/Regression v.buffer creates shapefile with no .prj Victor Olaya 2015-01-22 07:44 AM

12034 Bug report Closed Severe/Regression Processing - Raster GRASS algorithms are not working Giovanni Manghi 2015-01-22 08:16 AM

12034 Bug report Closed Severe/Regression Processing - Raster GRASS algorithms are not working Giovanni Manghi 2015-01-22 08:16 AM

11951 Bug report Closed Severe/Regression Python error while using tools with output to a folder instead of a file Victor Olaya 2015-02-19 08:21 PM

11951 Bug report Closed Severe/Regression Python error while using tools with output to a folder instead of a file Victor Olaya 2015-02-19 08:21 PM

11884 Bug report Closed Severe/Regression Processing generates outputs with no "+towgs84" parameters Victor Olaya 2017-02-27 03:04 PM

11884 Bug report Closed Severe/Regression Processing generates outputs with no "+towgs84" parameters Victor Olaya 2017-02-27 03:04 PM

11842 Bug report Closed Normal Python error shown after clicking "Run" on an algorithm in an empty project Victor Olaya 2014-12-11 04:38 AM

11842 Bug report Closed Normal Python error shown after clicking "Run" on an algorithm in an empty project Victor Olaya 2014-12-11 04:38 AM

11759 Bug report Closed Normal Python error when running "Import Vector into PostGIS database (available connections)" Giovanni Manghi 2015-01-31 01:45 PM

11759 Bug report Closed Normal Python error when running "Import Vector into PostGIS database (available connections)" Giovanni Manghi 2015-01-31 01:45 PM

11691 Feature request Open Normal Use ogr2ogr to create an Intersect tool that accepts more than two vectors Giovanni Manghi 2017-05-01 12:47 AM

11691 Feature request Open Normal Use ogr2ogr to create an Intersect tool that accepts more than two vectors Giovanni Manghi 2017-05-01 12:47 AM

11690 Feature request Open Normal Use ogr2ogr to create Union tool that accepts more than 2 input vectors Giovanni Manghi 2017-05-01 12:47 AM

11690 Feature request Open Normal Use ogr2ogr to create Union tool that accepts more than 2 input vectors Giovanni Manghi 2017-05-01 12:47 AM

11688 Feature request Closed Normal Translate (convert format): add a batch option that creates outputs with the name of the corresponding input Victor Olaya 2014-11-20 03:16 AM

11688 Feature request Closed Normal Translate (convert format): add a batch option that creates outputs with the name of the corresponding input Victor Olaya 2014-11-20 03:16 AM

11636 Feature request Closed Normal ogr2ogr to select disjoint features Giovanni Manghi 2019-03-11 02:38 PM

11636 Feature request Closed Normal ogr2ogr to select disjoint features Giovanni Manghi 2019-03-11 02:38 PM

11635 Feature request Open Normal ogr2ogr to merge several shapefiles in a folder Giovanni Manghi 2017-05-01 12:47 AM

11635 Feature request Open Normal ogr2ogr to merge several shapefiles in a folder Giovanni Manghi 2017-05-01 12:47 AM

11575 Feature request Closed Normal Create rectangles, ovals and diamonds from points (not by digitizing) Victor Olaya 2016-04-13 02:32 AM

11575 Feature request Closed Normal Create rectangles, ovals and diamonds from points (not by digitizing) Victor Olaya 2016-04-13 02:32 AM

11569 Feature request Closed Normal Use ogr2ogr to Dissolve polygons Giovanni Manghi 2015-06-19 01:27 PM

11569 Feature request Closed Normal Use ogr2ogr to Dissolve polygons Giovanni Manghi 2015-06-19 01:27 PM

11527 Bug report Closed Normal Processing  - Regular points - QGIS freezes when clicking on "Open number input dialog" Alexander Bruy 2014-11-03 06:22 AM

11527 Bug report Closed Normal Processing  - Regular points - QGIS freezes when clicking on "Open number input dialog" Alexander Bruy 2014-11-03 06:22 AM

11515 Feature request Closed Normal Use ogr2ogr to create midpoints along lines Giovanni Manghi 2015-06-19 01:28 PM

11515 Feature request Closed Normal Use ogr2ogr to create midpoints along lines Giovanni Manghi 2015-06-19 01:28 PM

11501 Feature request Closed Normal Add the command line log to GDAL/OGR algorithms Victor Olaya 2014-11-21 06:02 AM
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11501 Feature request Closed Normal Add the command line log to GDAL/OGR algorithms Victor Olaya 2014-11-21 06:02 AM

11496 Feature request Closed Normal Delete recently used algorithms in Processing option Victor Olaya 2014-10-25 04:42 AM

11496 Feature request Closed Normal Delete recently used algorithms in Processing option Victor Olaya 2014-10-25 04:42 AM

11495 Bug report Rejected Normal it is not possible to select the extent of another layer in the Modeler Victor Olaya 2015-05-20 01:21 AM

11495 Bug report Rejected Normal it is not possible to select the extent of another layer in the Modeler Victor Olaya 2015-05-20 01:21 AM

11448 Feature request Closed Normal Add clipping with ogr2ogr with "-clipsrc" option Victor Olaya 2014-10-26 03:23 AM

11448 Feature request Closed Normal Add clipping with ogr2ogr with "-clipsrc" option Victor Olaya 2014-10-26 03:23 AM

11363 Bug report Closed Normal R scripts: help file is created but not shown in the Help tab Victor Olaya 2017-05-01 11:06 AM

11363 Bug report Closed Normal R scripts: help file is created but not shown in the Help tab Victor Olaya 2017-05-01 11:06 AM

11345 Bug report Closed High Python error while using "Get script from online scripts collection" 2014-10-07 01:59 PM

11345 Bug report Closed High Python error while using "Get script from online scripts collection" 2014-10-07 01:59 PM

11328 Feature request Closed High Increase the font size in the Modeller and in the Script editor Victor Olaya 2016-02-15 11:37 PM

11328 Feature request Closed High Increase the font size in the Modeller and in the Script editor Victor Olaya 2016-02-15 11:37 PM

11327 Bug report Closed High Python error while trying to create a model Victor Olaya 2014-10-08 12:24 AM

11327 Bug report Closed High Python error while trying to create a model Victor Olaya 2014-10-08 12:24 AM

10883 Feature request Closed Normal DB Manager: add a timer to the SQL window 2015-09-04 12:02 PM

10883 Feature request Closed Normal DB Manager: add a timer to the SQL window 2015-09-04 12:02 PM

10873 Bug report Closed Normal Select by location: does not work as expected Victor Olaya 2015-06-07 04:31 AM

10873 Bug report Closed Normal Select by location: does not work as expected Victor Olaya 2015-06-07 04:31 AM

10488 Bug report Closed Severe/Regression Identify tool: selection does not disappear when the layer is deactivated 2014-06-06 07:09 AM

10488 Bug report Closed Severe/Regression Identify tool: selection does not disappear when the layer is deactivated 2014-06-06 07:09 AM

10118 Feature request Closed Normal On the raster "save as" the "layer extent" should be computed automatically 2019-02-13 09:43 PM

10118 Feature request Closed Normal On the raster "save as" the "layer extent" should be computed automatically 2019-02-13 09:43 PM

10111 Bug report Closed Severe/Regression "Save as" is not working with rasters 2014-04-25 11:51 AM

10111 Bug report Closed Severe/Regression "Save as" is not working with rasters 2014-04-25 11:51 AM

10097 Bug report Closed Severe/Regression Activating or deactivating a layer makes QGIS refresh WMS layers 2014-06-09 03:00 AM

10097 Bug report Closed Severe/Regression Activating or deactivating a layer makes QGIS refresh WMS layers 2014-06-09 03:00 AM

10064 Bug report Closed Severe/Regression QGIS-Processing is broken in Master 2014-04-21 03:48 AM

10064 Bug report Closed Severe/Regression QGIS-Processing is broken in Master 2014-04-21 03:48 AM

9604 Bug report Closed Normal Attribute table: the icons for "Unselect all" and "Delete selected features" are too similar 2014-11-22 05:24 AM

9604 Bug report Closed Normal Attribute table: the icons for "Unselect all" and "Delete selected features" are too similar 2014-11-22 05:24 AM

9477 Feature request Closed Normal GDAL translate: support ESRI rasters folders names as inputs 2014-11-19 07:41 AM

9477 Feature request Closed Normal GDAL translate: support ESRI rasters folders names as inputs 2014-11-19 07:41 AM

9402 Feature request Closed Normal Make the new Field Calculator tool available in the Modeler Alexander Bruy 2016-02-20 02:16 AM

9402 Feature request Closed Normal Make the new Field Calculator tool available in the Modeler Alexander Bruy 2016-02-20 02:16 AM

9400 Bug report Closed Normal "Clip raster by mask layer" produces different results than "Clipper" from Raster Menu Alexander Bruy 2016-05-23 07:14 AM

9400 Bug report Closed Normal "Clip raster by mask layer" produces different results than "Clipper" from Raster Menu Alexander Bruy 2016-05-23 07:14 AM

8919 Bug report Closed High R scripts: not possible to export .csv Victor Olaya 2017-05-01 11:06 AM

8919 Bug report Closed High R scripts: not possible to export .csv Victor Olaya 2017-05-01 11:06 AM

8909 Feature request Rejected Normal Add "R dependencies" to R scripts Help files Victor Olaya 2017-05-03 07:32 PM

8909 Feature request Rejected Normal Add "R dependencies" to R scripts Help files Victor Olaya 2017-05-03 07:32 PM

8743 Feature request Closed Normal Field calculator: allow "Formula" to receive a value from a "Number" parameter Victor Olaya 2019-01-15 05:37 PM

8743 Feature request Closed Normal Field calculator: allow "Formula" to receive a value from a "Number" parameter Victor Olaya 2019-01-15 05:37 PM

8719 Feature request Closed Normal Allow users to predefine some paramater/vector layer/raster layer choices in Models Victor Olaya 2017-02-09 11:16 AM

8719 Feature request Closed Normal Allow users to predefine some paramater/vector layer/raster layer choices in Models Victor Olaya 2017-02-09 11:16 AM

8341 Bug report Closed Severe/Regression GDAL clipper returns "ERROR: Did not get any cutline features". with "mask layer" 2013-07-22 09:30 AM

8341 Bug report Closed Severe/Regression GDAL clipper returns "ERROR: Did not get any cutline features". with "mask layer" 2013-07-22 09:30 AM

8281 Feature request Open Normal Change the way .gpx and .kml are created 2017-05-01 12:48 AM

8281 Feature request Open Normal Change the way .gpx and .kml are created 2017-05-01 12:48 AM

8264 Bug report Closed High error when trying to load a layer that wasn't actually created Victor Olaya 2015-06-07 01:18 AM

8264 Bug report Closed High error when trying to load a layer that wasn't actually created Victor Olaya 2015-06-07 01:18 AM

8069 Bug report Closed Normal Ftools random points: a python error 2017-05-01 01:21 AM

8069 Bug report Closed Normal Ftools random points: a python error 2017-05-01 01:21 AM

8004 Bug report Closed Severe/Regression New Shapefile Layer: it's not possible to select a CRS from the "Recently used CRS" window 2013-06-05 11:36 AM

8004 Bug report Closed Severe/Regression New Shapefile Layer: it's not possible to select a CRS from the "Recently used CRS" window 2013-06-05 11:36 AM

7967 Feature request Closed Low Modeler: Output of a tool is not graphically used as the input of the next tool Victor Olaya 2017-06-29 01:15 AM

7967 Feature request Closed Low Modeler: Output of a tool is not graphically used as the input of the next tool Victor Olaya 2017-06-29 01:15 AM

7691 Feature request Closed Normal Add scroll bar to print composer 2014-02-13 06:38 AM

7691 Feature request Closed Normal Add scroll bar to print composer 2014-02-13 06:38 AM

7677 Bug report Closed Severe/Regression Qgis crashes after dissolving a shapefile 2017-05-01 01:21 AM

7677 Bug report Closed Severe/Regression Qgis crashes after dissolving a shapefile 2017-05-01 01:21 AM

6817 Bug report Closed Severe/Regression Qgis crashes while trying to edit a symbol in "graduated symbology" 2013-02-20 04:32 AM

6817 Bug report Closed Severe/Regression Qgis crashes while trying to edit a symbol in "graduated symbology" 2013-02-20 04:32 AM

6787 Bug report Closed Normal On the Menu bar "File" oftern shows up in the place of "Settings" and vice versa 2013-01-04 01:13 AM

6787 Bug report Closed Normal On the Menu bar "File" oftern shows up in the place of "Settings" and vice versa 2013-01-04 01:13 AM

6785 Bug report Closed High Error while trying to edit a parameter in a model Victor Olaya 2014-10-20 12:34 AM

6785 Bug report Closed High Error while trying to edit a parameter in a model Victor Olaya 2014-10-20 12:34 AM

6775 Bug report Closed Severe/Regression The values of a field created with field calculator (float) are rounded when they should have decimal places Nathan Woodrow 2012-11-28 01:32 AM

6775 Bug report Closed Severe/Regression The values of a field created with field calculator (float) are rounded when they should have decimal places Nathan Woodrow 2012-11-28 01:32 AM

6299 Bug report Closed High Sextante output do not have the same Encoding as the inputs Victor Olaya 2015-12-19 12:10 PM

6299 Bug report Closed High Sextante output do not have the same Encoding as the inputs Victor Olaya 2015-12-19 12:10 PM

5976 Bug report Closed Normal Python error after "Check geometry validity" 2017-05-01 01:22 AM

5976 Bug report Closed Normal Python error after "Check geometry validity" 2017-05-01 01:22 AM

5825 Bug report Closed High Print Composer Refresh broken Marco Hugentobler 2012-07-11 11:41 PM

5825 Bug report Closed High Print Composer Refresh broken Marco Hugentobler 2012-07-11 11:41 PM

5615 Bug report Closed High Qgis crashes frequently when digitizing streams over aerial images (via WMS and with tiff) 2013-05-31 07:39 AM

5615 Bug report Closed High Qgis crashes frequently when digitizing streams over aerial images (via WMS and with tiff) 2013-05-31 07:39 AM

5527 Bug report Closed High Attribute table: Search Query builder crashes when doing a search in shapefile with 124000 features 2012-05-03 03:11 AM

5527 Bug report Closed High Attribute table: Search Query builder crashes when doing a search in shapefile with 124000 features 2012-05-03 03:11 AM

5525 Bug report Closed Severe/Regression "Show selected only" in the Attribute table causes QGIS to crash when the number of selected features is high 2013-04-13 07:43 AM

5525 Bug report Closed Severe/Regression "Show selected only" in the Attribute table causes QGIS to crash when the number of selected features is high 2013-04-13 07:43 AM

5524 Bug report Closed Low Erratic behaviour of Union tool 2017-05-01 01:22 AM

5524 Bug report Closed Low Erratic behaviour of Union tool 2017-05-01 01:22 AM

5523 Bug report Closed Normal Deleting columns from the Attribute Table - QGIS very slow 2012-06-12 12:48 PM

5523 Bug report Closed Normal Deleting columns from the Attribute Table - QGIS very slow 2012-06-12 12:48 PM

5501 Feature request Closed Normal "Union/Intersect" tools that allows more than 2 input files 2017-05-01 01:22 AM
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5501 Feature request Closed Normal "Union/Intersect" tools that allows more than 2 input files 2017-05-01 01:22 AM

5269 Bug report Closed High New fields created by "table join" are limited to 80 characters when it should be 255 2012-10-08 02:45 AM

5269 Bug report Closed High New fields created by "table join" are limited to 80 characters when it should be 255 2012-10-08 02:45 AM

4924 Feature request Feedback Normal Join attributes - add the option of creating a shapefile with matching attributes only Marco Hugentobler 2017-05-01 12:50 AM

4924 Feature request Feedback Normal Join attributes - add the option of creating a shapefile with matching attributes only Marco Hugentobler 2017-05-01 12:50 AM

4896 Feature request Closed Low Add "Join table" button when right-clicking on a vector layer 2016-06-09 09:05 PM

4896 Feature request Closed Low Add "Join table" button when right-clicking on a vector layer 2016-06-09 09:05 PM

4870 Bug report Closed Low Plugin reorganization: Move "Table Manager" plugin to "Vector" Menu and "Open Layers" do "Web" menu 2013-02-08 04:03 AM

4870 Bug report Closed Low Plugin reorganization: Move "Table Manager" plugin to "Vector" Menu and "Open Layers" do "Web" menu 2013-02-08 04:03 AM

4739 Feature request Open Normal Browser: allow renaming, moving and deleting datasources 2017-05-01 12:50 AM

4739 Feature request Open Normal Browser: allow renaming, moving and deleting datasources 2017-05-01 12:50 AM
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